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Troubleshooting SGM and the 
Network

This chapter provides the following information for troubleshooting basic SGM 
and network problems:

• Verifying Discovery, page 6-1

• Clearing a Locked-Up SGM Display, page 6-2

• Investigating Data Problems, page 6-2

• Viewing the SGM Troubleshooting Log, page 6-3

• Viewing SGM Data on the Web, page 6-4

• Diagnosing a Typical Network Problem, page 6-4

Verifying Discovery
After you discover the network (see the “Discovering the Network” section on 
page 3-6), examine the Discovered Nodes table to verify that SGM discovered all 
of the ITP nodes in the network. If you suspect that SGM did not discover all of 
the ITP nodes, verify the following conditions:

• Verify that no nodes are excluded from your current view.

• Verify that the SGM server can ping the nodes.

• Verify that the nodes are running images that are compatible with the SGM 
server.
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• Verify that the SNMP is enabled on the nodes.

• Verify that SGM is configured with the correct SNMP community name. See 
the “Configuring SNMP” section on page 3-2 for details.

• Verify that the missing nodes are connected to the seed nodes by SCTP 
connections, not just serial connections. If they are not connected by SCTP 
connections, you must add the missing nodes to the seed file as seed nodes. 
See the “Configuring Seed Files” section on page 3-20 for more information.

• Verify that you selected Entire Network when you ran Discovery. If you 
suspect that you did not, run Discovery again with Entire Network selected.

Clearing a Locked-Up SGM Display
In SGM, events might cause message popups to remain in the background of your 
display, preventing you from interacting with other windows. If you suspect that 
your display has locked up, perform the following tasks:

• Make sure you are running SGM on a supporrted operating system. Refer to 
the “Solaris Software Requirements” and “Windows Software Requirements” 
sections of the Cisco Signaling Gateway Manager Installation Guide for 
more information about supported operating systems.

• Minimize windows and look for an SGM message popup in the background.

Investigating Data Problems
If you suspect that there are problems with the data that SGM is displaying, 
perform the following tasks:

• Enter equivalent show commands on the ITP. Is the data the same as that 
displayed by SGM?

• Send SNMP queries to the nodes. Do all queries complete?

The results of these tasks can help you distinguish between an ITP problem and 
an SGM problem.
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Viewing the SGM Troubleshooting Log
SGM stores troubleshooting information in the 
/opt/CSCOsgm/tmp/cisco_sgm_tshoot.log file on the SGM server. This log, which 
is updated each time the SGM Server Troubleshooting page is accessed or the sgm 
tac command is run, contains information that might be requested by Cisco 
customer support personnel.

If you want to view the SGM troubleshooting log, Cisco strongly recommends 
that you do so in a Web browser. To view the log in a Web browser, select System 
Troubleshooting from the SGM Server Home Page.

You can also view the log from the command line, but this method displays the 
entire log, which can contain thousands of lines of output, line-by-line on your 
workstation screen. Therefore, Cisco strongly recommends that you view the log 
from the Web, as indicated above, or redirect the output from this command to a 
separate file, using the redirection symbol (>).

To view the log from the command line:

Step 1 Log in as the root user, as described in the “Becoming the Root User (Solaris 
Only)” section on page 3-2, or as a super user, as described in the “Specifying a 
Super User (Solaris Only)” section on page 4-22.

Step 2 Enter the following commands:

# cd /opt/CSCOsgm/bin

# ./sgm tac

This command might take a minute or more to complete. When it completes, SGM 
displays the following message and prompt:

Output is in /opt/CSCOsgm/tmp/cisco_sgm_tshoot.log

Would you like to view it? [y]

Step 3 Press Enter. SGM displays the contents of the 
/opt/CSCOsgm/tmp/cisco_sgm_tshoot.log file.
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Viewing SGM Data on the Web
SGM provides an enormous amount of Web-based troubleshooting information. 
From the SGM Server Home Page, you can access many Web pages containing 
SGM data, including server status, network status, installation logs, message logs, 
product documentation, and other important troubleshooting information about 
SGM. For full details, see the “Accessing SGM Data from a Web Browser” 
section on page 7-1.

Viewing Detailed Troubleshooting Instructions for 
Events

SGM provides extensive type-specific help and troubleshooting instructions for 
events. To see help and troubleshooting instructions for an event, right-click the 
event in the Event Window and select Help for Event.

You can also provide your own enterprise-specific instructions to operators in the 
event help. For more information, see the “Modifying Help for Events” section on 
page 5-37.

Diagnosing a Typical Network Problem
When you use SGM to diagnose a problem in an ITP network, follow these basic 
steps:

1. Monitor the network using the Link, Linkset, Signaling Point, Node, and 
Topology windows. For example, an object in the topology map that changes 
color from green to yellow or red indicates a problem in the network.

2. Use SGM windows, especially the Details window, to begin investigating the 
problem.

3. As you identify the source of the problem, examine the messages logged by 
SGM for more detailed information about the sequence of events that led to 
the problem.

4. Telnet to the problematic ITP, if necessary.
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The following real-life example provides detailed information about using SGM 
to diagnose a problem in an ITP network:

Step 1 A network operator (we’ll call him Joe) is using SGM to monitor an ITP network. 
Joe has customized his view, limiting it to only those nodes for which he is 
responsible.

(For more information about customizing views, see the “Working with Views” 
section on page 3-26.)

Step 2 In the topology map, Joe notices a signaling point that has changed color from 
green to yellow. Yellow indicates a status of Warning, which means that one or 
more links or linksets associated with that signaling point is in Unknown or 
Warning status and is not flagged as Ignored.

(For more information about signaling point status, see the “Working with 
Signaling Points” section on page 3-136.)

Step 3 Joe single-clicks the signaling point in the topology map.

SGM highlights the signaling point in the topology map, and in the topology 
signaling point table, in the left pane of the Topology window. With the signaling 
point highlighted, Joe can easily see that the name of the signaling point is 
sgm-7500j.

SGM also displays all associated linksets in the topology linkset table.

Joe double-clicks the signaling point’s name in the topology signaling point table.

SGM redraws the topology map, centered on sgm-7500j, making it easier for Joe 
to see the relevant portion of the map.

(For more information about the Topology window and how to use it, see the 
“Viewing the Topology of the Network” section on page 3-259.)

Step 4 Joe notices that one of sgm-7500j’s diamonds is red, indicating that the associated 
linkset is either Unavailable or Unknown. Joe single-clicks the red diamond.

SGM highlights the linkset in the topology map and in the topology linkset table. 
The table entry indicates that the linkset is Unavailable.

(For more information about linkset status, see the “Viewing Basic Information 
for Linksets” section on page 3-38.)
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Step 5 Joe right-clicks the linkset in the topology map and selects View > Configuration 
Details in the right-click menu.

SGM opens the Details window, showing detailed information for the linkset.

In the Details window, detailed information for the selected linkset is displayed in 
the left column and for the adjacent linkset in the right column

Immediately, Joe sees that the left column is populated with SGM data, but the 
right column is not. The problem is in the adjacent signaling point-to-primary 
signaling point linkset.

(For more information about linkset details, see the “Viewing Detailed 
Information for a Linkset” section on page 3-42.)

Step 6 The turner beside Linkset in the left pane displays the list of links associated with 
the linkset, identified by their signaling link code IDs (SLCs). In this case, there 
is only one link listed, SLC 0, and it is red, meaning it is Failed and there is no 
traffic flowing on the link.

Joe selects SLC 0, and SGM displays detailed information for the link in the left 
column. Normally SGM also displays detailed information for links associated 
with the adjacent linkset in the right column, but in this case, that column is blank.

(For more information about linkset status, see the “Viewing Detailed Information 
for a Link” section on page 3-175.)

Step 7 Joe decides to investigate the adjacent signaling point, so he double-clicks the 
adjacent signaling point in the topology map.

The resulting display shows that the adjacent signaling point, sgm-2600a, is 
Unmanaged.

(For more information about signaling point details, see the “Viewing Detailed 
Information for a Signaling Point” section on page 3-141.)

Step 8 Joe closes the Details window and returns to the Topology window. He tries to 
find sgm-2600a in the topology map, but the map is too complex. So Joe lets SGM 
find the node for him:

a. He selects Edit > Find in the SGM Main Menu. SGM displays the Find 
dialog.

b. He enters sgm-2600a in the Search string field, selects the Signaling Points 
checkbox, and makes sure the Name, checkbox is selected.
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c. He clicks OK to launch the search. Almost immediately, SGM finds the node 
and displays the Choose dialog, listing all found objects.

d. Joe selects sgm-2600a, and SGM automatically highlights sgm-2600a in the 
topology signaling point table and in the topology map, and redraws the map 
centered on sgm-2600a.

(For more information about finding objects in the topology map, see the 
“Viewing the Topology of the Network” section on page 3-259.)

Step 9 Joe wants to see recent events for sgm-2600a, so he clicks the node in the 
topology map and selects View > Events in the SGM Main Menu. SGM displays 
the Event Window, showing recent events for sgm-2600a.

(For more information about viewing events, see the “Working with Events” 
section on page 3-235.)

Step 10 Joe decides to see if SGM can manage the signaling point. He right-clicks 
sgm-2600a in the topology map and selects Manage in the right-click menu.

SGM changes the status of the signaling point from Unmanaged (red) to 
Warning (yellow), which means the signaling point is active, but one or more 
associated linksets or links has a status of Failed, Unavailable, Unknown, or 
Warning and is not flagged as Ignored.

(For more informations, see the “Unmanaging and Managing a Signaling Point” 
section on page 3-169.)

Step 11 Joe wants to see status change messages for sgm-2600a, so he right-clicks the 
signaling point again and selects Event History > Status Change Messages in 
the right-click menu. SGM displays recent status change messages for the 
signaling point in a Web browser.

Joe sees that many of the links and linksets associated with sgm-2600a have a 
status of Unknown.

(For more information about displaying messages on the Web, see the “Accessing 
SGM Data from a Web Browser” section on page 7-1.)
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Step 12 At this point, Joe needs to determine why so many of the links and linksets are 
Unknown. He needs to verify that the SGM server can ping the node (see the 
“Telnetting to an ITP” section on page 5-52), and that SGM is configured with the 
correct SNMP community name for the node (see the “Configuring SNMP” 
section on page 3-2).

(For a list of some other actions Joe can take, see the “Verifying Discovery” 
section on page 6-1.)

Step 13 Finally, Joe can use another product, such as CiscoView, to further investigate the 
problem.

(For more information about integrating SGM with CiscoView and other 
products, see the “Integrating SGM with Other Products” section on page 3-401.)
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